Backup Help Contents

Using Backup, you can

e backup files from one or more drives

e restore a backup

e verify data on a backup with source data

Help topics for Backup are divided into categories represented by the following icons:
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Exiting Backup

. To exit Backup

Select Exit from the File menu.



Commands

e File menu

. Tree menu

o View menu

o Utilities menu

. Help menu



File menu

The commands that a menu contains depends on whether you're backing up, restoring, or verifying
data. The following list includes all the commands that may appear on a menu:

Tag Files Marks the checkbox for selected files.

Untag Files Unmarks the checkbox for selected files.

Find Backup Searches for a backup and recreates catalog files that have been deleted.

Backup Info Displays information about a backup.

Select Criteria Determines criteria that overrides marked checkboxes. You can specify backup
criteria, restore criteria, and verify criteria.

Backup Begins backing up data according to your criteria and selections.

Restore Begins restoring a backup according to your criteria and selections.

Veri Begins verifying a backup according to your criteria and selections.

Preferences Configures the default options used by Backup when backing up, restoring, and

verifying data.
Exit Closes Backup.



Tree menu

Expand One Level Displays the next directory level of the current branch.

Expand Branch
Expand All
Collapse Branch
Tag Branch
Untag Branch

Displays all the sub-directories of the current branch.
Displays all sub-directories of the selected drive.
Closes all the sub-directories of the selected branch.
Marks the checkbox for selected directories.
Unmarks the checkbox for selected directories.



View menu

Name Displays only the name of files displayed in the Files List box.

All File Details Displays the name, type, size, and date of file displayed in the Files List box.
Partial Details Displays only the file details you select for files displayed in the Files list box.

Sort by Name Lists files by name in the Files List box.

Sort by Type Lists files by type in the Files List box.

Sort by Size Lists files by size in the Files List box.

Sort by Date Lists files by date in the Files List box.

Reverse Sort Lists files in descending order in the Files List box according to the Sort By option.

Split Adjusts the size of the Directories and Files List boxes.



Utilities menu

The commands that a menu contains depends on whether you're backing up, restoring, or verifying
data. The following list includes all the commands that may appear on a menu:

Format Tape Prepares tape cartridges for use with Backup.

Rewind Tape Rewinds tape cartridges to the start of the tape.

Restore Files Displays the components of the window required to restore a backup.
Backup Files Displays the components of the window required to backup files.

Verify Files Displays the components of the window required to verify files.



Help menu

Contents Displays the main help index.
About Displays the version of Backup you're using.



How To...

Define Backup preferences
Format and rewind tape cartridges

Backup data
Restore data

Verify data

Work with directory structures and file information
Mark files and directories

Select criteria

Find backups

View backup information

Use SY-TOS tape cartridges



Defining Backup Preferences

You can configure the following default options using Backup:
e window view
screen saver functions
log file name and location text boxes
catalog file name and location
file restore options
You also set default preferences using the Configuration utility.

. To set backup preferences
1. Select Preferences from the File menu.
2. Modify the options.



Working with Directory Structures and File Information

You can use the Directories list box and Files list box to view various levels of the directory hierarchy,
display several types of file information, and sort files.

The Directories list box displays only directories. The Files list box displays the files and sub-directories
of the directory selected in the Directories list box. For each file displayed in the Files list box, you can
view several types of file details:

e the size of the file in bytes

e the date that the file was last modified

e the time that the file was last modified

¢ the attributes such as read-only or hidden that are assigned to the file

To help you view and locate files, the Files list box lets you sort files according to four sets of criteria:
e name -- sorts files alphabetically

e type -- sorts files by type

e size -- sorts files by size

e date -- sorts files by modification date

By default, files are sorted in ascending order: from smallest to largest, in alphabetical order and so on.

To display ... select...

the next level of sub-directories Expand One Level from the Tree menu.
for the directory selected in
the Directories List box

all sub-directories of the directory Expand Branch from the Tree menu.
selected in the Directories List box

all sub-directories of drive Expand All from the Tree menu.

selected in the Directories List box

files by name only in the Files Name from the View menu.

list box Or the Name button from the tool bar.

all details of files in the Files All File Details from the View menu.

list box Or the All File Details button from the tool bar.
a combination of details for files Partial Details from the View menu, mark the
in the Files list box details to include, and select the OK button.

files by name in the Files list box  Sort by Name from the View menu.

Or the Sort by Name button from the tool bar.
files by type in the Files list box Sort by Type from the View menu.

Or the Sort by Type button from the tool bar.
files by size in the Files list box Sort by Size from the View menu.

Or the Sort by Size button from the tool bar.
files by date in the Files list box Sort by Date from the View menu.

Or the Sort by Date button from the tool bar.
sorted files in descending order Reverse Sort from the View menu.

To close sub-directories of the directory selected in the Directories list box
Select Collapse Branch from the Tree menu.

. To adjust the width of the Directories and Files list boxes
1. Select Split from the View menu.
Or select the split bar located between the two list boxes.
2. Drag the split bar to the new location.
3. Click your mouse.



Formatting and Rewinding Tape Cartridges

You must use Backup to format tapes to prepare them for backup. When you format the cartridge, you
can specify a name and a comment to help you track your cartridges.

You can also choose whether to use error correction codes. Only QIC tape drives support error
correction code. If you aren't using a QIC tape drive, make sure that the Error Correction Code selection

box is unmarked.

You can rewind tapes using Backup to start backups at the beginning of the tape and to overwrite
existing information on the tape.

To format your tape

Select Format Tape from the Utilities menu.

Select a tape drive.

Enter a name for your tape.

Enter a comment.

Indicate whether you want to use error correction codes.
Select the Format button.

To rewind your tape

Select Rewind Tape from the Utilities menu.
Select the tape drive.

Select the Rewind button.
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Backing Up Data

Backing up your data protects your data if the original information is damaged or lost. For example, if
your system crashes, a backup ensures that you lose only the changes you've made since your last
backup.

The type of device to which you're backing up data affects how the backup works. You can backup to
three types of devices:

e tape drives

¢ hard disk and network drives

e removable drives

Tape Drives

You select a tape drive as the destination for the backup using the Backup Files To list box. The selected
tape drive must contain a cartridge formatted using Backup.

If a cartridge doesn't contain enough space to complete the backup, you're prompted to insert another
cartridge. Backup automatically formats the cartridge, if necessary, and specifies the same name and
comment as the first cartridge. Backup also assigns a number to each tape required for the backup. You
can use this number to identify the order that cartridges were used to backup files.

You may want to physically label your cartridges to identify sets of backup cartridges.

Hard Disks and Network Drives

You select a hard drive or network drive for the backup using the DOS Path of the Backup Files To list
box. Backup automatically checks that the hard drive or network drive contains enough space to
complete the backup.

Using the DOS Path Name text box, you enter the directory path for the backup. When you run the

backup, one backup file is automatically created in the DOS path you specified. The backup file contains

the backed up data. The name of the backup file specifies

¢ the date of the backup using the following format to specify the year, month, and day of the backup:
YYMD

e atwo character code that uniquely identifies the backup. This code is useful if you create two
backups on the same day.

e the extension .001

Removable Drives

You select a removable drive for the backup using the Backup Files To list box. When you backup data
to a removable drive using Backup, one or more backup files are created. Backup files contain the
backed up data.

If the disk or cartridge in the removable drive doesn't contain enough room for the backup, you're

prompted to insert another disk or cartridge. One backup file is automatically created on each disk or

cartridge. The name of the files specifies

¢ the date of the backup using the following format to specify the year, month, and day of the backup:
YYMD

e atwo character code that uniquely identifies the backup. This code is useful if you create two
backups on the same day.

e an extension that indicates the order that the backup files were created. The first backup file uses
the extension .001; the second file uses the extension .002, and so on.

About Backup Carryover

If you're backing up data to any device other than a hard disk and the media doesn't contain enough
space to store the entire backup, you're prompted to insert a new cartridge or disk when the first one is
full.

Low density QIC tapes (up to 525 MB) allow a block size of only 512 bytes. High density QIC tapes (525
MB and larger) are more flexible and allow a greater range of block sizes. If you're prompted to insert a
new tape during a backup and you're backing up to QIC tapes, you may encounter an error message



related to the block size of the new cartridge. In most cases, the backup originated on a tape with a
block size of 1024 bytes and the tape you inserted is a low density tape, which can't be set to 1024
bytes. A higher density tape is required to continue the backup.

About Busy Files

The backup won't include any marked files that were busy when the backup tried to read them.
Information about busy files is recorded in the catalog file. Although no information about busy files is
written to the backup file, a special file icon is displayed beside the file name when you list the files
included in the backup using the restore options.

1.
2.

3.
4.

To backup your data

Select Backup Files from the Utilities menu.

Identify the data you want to backup using the Backup Files From, Directories, and Files list
boxes.

Define backup criteria using the Select Criteria command of the File menu. This step is optional.
Define the location where you want the backup stored using the Backup Files To drop down list

box.

Name the backup and enter a comment using the Backup Name and Backup Comment text
boxes. Comments are optional. However, comments help you identify backups if you need to
restore one.

Indicate whether you want the backup verified using the Verify After Backup selection box. This
step is optional.

Indicate whether you want the archive attribute of the backed up files cleared using the Clear
Archive Attribute selection box. This step is optional.

Start the backup using the Backup button on the tool bar or the Backup command of the File
menu.




Backup Files From list box
Lists the drives from which you can backup data. By default, all the files on the default hard drive are
marked for backup.

When you highlight a drive in the Backup Files From list box, the contents of the drive are listed in the
Directories and Files list boxes. From these list boxes, you can select the files and sub-directories you

want to include in the backup.



Backup Files To drop down list box

Lists locations where you can store the backup. You can select tape drives, removable drives, and DOS
Path. Backup prevents you from entering a destination that's the same as the original data.

If you select DOS path, you must enter the path in the DOS path name text box. Do not include a file
name in the DOS path. The backup files are created and named by Backup.



Verify After Backup checkbox

Indicates whether the backup will be verified to ensure that files have been properly copied. Backup

compares the original information to the backup and checks for any discrepancies between the two
copies.

If you change your devices, you may want to verify a few backup operations. For example, if there's a

problem with communication to a device, verifying the backup ensures that all the files were successfully
copied.
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Restoring Data

Restoring your backups rebuilds information that was lost or damaged. For any backup that you have
performed, you can restore it to the original destination or to a new location.

Catalog files contain the information required to restore a backup. This information includes the names
of the files backed up, their directory structures, and files that were busy during the backup. Catalog files
are automatically created by the backup and are stored on your hard drive.

The default location of catalog files is defined using the Preferences command of the Backup file menu

or the Backup component of the Configuration utility. The name of the catalog file specifies

¢ the date of the backup using the following format to specify the year, month, and day of the backup:
YYMD

e atwo character code that uniquely identifies the backup. This code is useful if you create two
backups on the same day.

e the extension .CAT

Deleting Catalog Files

If you reformat a tape cartridge using Backup and the cartridge contained backups, the associated
catalog files are deleted automatically.

For other types of media, however, you may need to delete catalog files yourself. For example, if you
reformat a floppy disk that contains backup files, the catalog files for those backups remain on your hard
drive. Similarly, if you use a utility other than Backup to reformat a tape cartridge, the associated catalog
files aren't deleted.

You can delete unnecessary catalog files just as you would delete any other file from your Windows
environment.
Before deleting catalog files, you must exit Backup.

Make sure that you delete catalog files only if you've already deleted the backup files. If you're required
to recreate the catalog files and you're missing one or more of the media on which you stored the
backup, you may end up with partial files. Partial files are represented in the Files list box by only the top
portion of the file icon.

Recreating Catalog Files

You can't restore a backup without catalog files. If you delete catalog files, you can use the Find
Backups command of the File menu in restore mode to scan the media on which the backup is stored
and recreate the catalog files.

To restore a backup

Select Restore Files from the Utilities menu.

2. ldentify the information you want to restore using the Backups list box and, optionally, the
Directories, and Files list boxes.

3. Select a destination for the restored data using the Restore Files To list. Indicate whether you
want the restored data verified using the Verify After Restore checkbox.

4. Start the restore using the Restore button on the tool bar or the Restore command of the File
menu.

=

. To recreate a catalog file

1. Select Find Backup from the File menu.
2. Select the Tape Drive or Removable Disk radio button, select the drive from the drop down list
box, and select the Find button.

Or select the DOS Path radio button and select the Browse button to choose a backup.
3. Select the Scan Media button.



Backups list box

Lists the available backups that you can choose to restore. When you highlight a backup, the Disks in
Selected Backup list box lists the drives from which the backup files originated. You can mark these
drives so that they may be included in or excluded from the restore.



Directories list box

Files list box

The Directories list box displays the directory hierarchy of the backup highlighted in the Backups list box.
The Files list box displays the files and sub-directories of the backup highlighted in the Backups list box.
If you don't want to include all the directories and files in the selected drive in the backup, restore, or
verify operation, you can mark directories and files to include using the checkbox displayed beside each
directory name.

You can use the window split bar to adjust the width of the Directories and Files list boxes.



Restore Files To drop down list box

Lists locations where you can restore the backup. You can restore the files in the backup to their original
locations or to a DOS path you specify.

If you restore files to their original locations, by default, sub-directories are recreated if they no longer
exist.

If you choose DOS Path, enter the path in the DOS Path text box. Files will be restored to the root of the
DOS path by default.



Verify After Restore checkbox

Indicates whether the restore will be verified to ensure that files have been properly copied. Backup

compares the restored information to the backup and checks for any discrepancies between the two
copies.

If you change your devices, you may want to verify a few restore operations. For example, if there's a

problem with communication to a device, verifying the restore ensures that all the files were successfully
copied.



Verifying Data

Tape cartridges can deteriorate over time. Using Backup, you can verify cartridges to confirm that the
data is still valid. You may also want to use the verify options to compare information on your media with
existing backups to ensure that you haven't lost data if you're having problems with your media.

To verify your data

Select Verify Files from the Utilities menu.

Find the backup you want to verify and view its information, if necessary.

3. Identify the data you want to verify using the Backups list box, the Disks in Selected Backup list

box, and the Directories and Files list boxes.

Define verify criteria using the Select Criteria command of the File menu. This step is optional.

5. Define the location of the files with which you want to verify the backup using the Compare with
Files In list box. If you choose DOS Path, enter the path in the DOS Path Name text box.

6. Indicate whether you want to compare sub-directories of the original directory structure using the
Compare Subdirectories list box. This step is optional.

7. Start the verification using the Verify button on the tool bar or the Verify command of the File
menu.
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Backups list box

Lists the available backups that you can choose to verify. When you highlight a backup, the

e Disks in Selected Backup list box lists the drives from which the backup files originated

e Directories and Files list boxes display the contents of the backup that you can mark for verification



Disks in Selected Backup list box

Displays the drives from which the backup files originated. You can mark these drives so that they may
be included in or excluded from the verification.



Compare with Files In drop down list box

Lists information that you can compare with the backup. You can compare a backup to the original files
or to the files in a DOS path you specify.

If you compare files to their original locations, sub-directories are compared automatically. If you define a
DOS path for the verification, the files are compared to files on the root of the DOS path by default. You
must specify Compare Sub-directories to compare files using their original directory structure.



Compare Sub-directories

Compares the backup to files in the specified DOS path using the original directory structure. This
selection box is selected by default.



DOS Path Name text box

Indicates the location of the files with which you want the backup compared. You must select "DOS path
name" from the Compare With Files In drop down list box to use the DOS path name text box.



Marking Files and Directories

To backup, restore, or verify data, you mark the information that you want to include in the operation.

When a checkbox displays an "X", all the information in the associated drive, directory, or file is marked.
An unmarked checkbox indicates that none of the associated information will be included in the
operation.

If the checkbox for a drive or directory is both marked and grayed, only some of the associated
information will be included in the operation.

. To mark a checkbox
Select the checkbox using the left mouse button until an "X" is displayed.
Or highlight a directory name and select Tag branch from the Tree menu.
Or highlight one or more file names and select Tag Files from the Tree menu.
Or highlight one or more file names and select the Tag Files button from the tool bar.

To unmark a directory
Select the checkbox using the left mouse button the "X" disappears.
Or highlight a directory name and select Untag branch from the Tree menu.
Or highlight one or more file names and select Untag Files from the Tree menu.
Or highlight one or more file names and select the Untag Files button from the tool bar.
v When selecting file names, you can use shift and ctrl to select consecutive and non-consecutive
names just as you do in any standard Windows application.



Selecting Criteria

You can specify criteria that overrides the files and directories that you've marked. For example, if you
use the criteria to exclude hidden files during a backup, any tagged, hidden files won't be included in the
backup.

Using the selection criteria, you can

e include only files with an archive attribute that's turned on

e exclude hidden, archived, read-only, or system files

e specify a date range for which only files modified between the specified dates are included
¢ include or exclude files by type

. To select criteria

1. Select Select Criteria from the File menu.
2. Modify the options.



Finding Backups
Eventually, the Backups list box may contain a long list of backups. You can create a short list of
backups using the Find Backup command of the File menu. This command lets you scan for all the

backups on a particular device instead of searching through the Backups list box.
v The Find Backup command is also used for creating catalog files.

To find a backup

1. Select Find Backup from the File menu.

2. Select the Tape Drive or Removable Disk radio button, select the drive from the drop down list
box, and select the Find button.
Or select the DOS Path radio button and select the Browse button to choose a backup.

. To display information about a listed backup
Select the Backup Info button.



Viewing Backup Information

Before you restore or verify a backup, you can view the following information about the backup:
the comment you specified for the backup

the size of the backup file

the date and time of the backup

the drives on which the backup files are located

the media on which backup files are stored and the name of the backup files

the catalog file names

. To view information about a backup
Select Backup Info from the File menu when using either the restore or verify window.



Using SY-TOS Tape Cartridges

Backup can read tapes written with SY-TOS. If you want to restore these tapes, you must add the
following line to the [CorelSCSI Backup] section of your CRLSCSL.INI file:
bSyTOS=1
If the tapes were written with a version of SY-TOS later than version 1.32, you must also add the
following:
bSyTOS_132=0
’ You must remove these lines from the CRLSCSI.INI file if you want to restore backups created
using backup utilities -- CTBACKUP or WTBACKUP -- provided with previous versions of CorelSCSI.



Glossary
archive attribute
backup files
cataloqg files

log file
media




archive attribute

Atoggle used by DOS to indicate changed files. For example, assume that you clear the archive
attribute of files you backup. If you then modify a file, DOS turns the archive attribute on.



backup files
One or more backup files are created when you backup data. These files contain the backed up data.



catalog files

Created when you backup data. Do not delete the catalog files. These files store information that's
required to restore the files. For example, catalog files include the names of the files backed up and their
original location.



log file
A file in which information generated by a backup, restore, or verify operation is recorded.



media

A generic term that refers to all types of disk storage including rewritable, WORM, and tape cartridges,
compact disks, and hard drives.



window view

Indicates whether the Backup window shrinks to an icon when backup, restore, and verify operations are
in progress.



screen saver

Indicates whether screen savers you're using work when backup, restore, and verify operations are in
progress. Using screen savers can slow down these operations.



log file name and location text boxes
Indicate the default name and location of the log file, if it's used. A log file records information generated

by Backup. Each time you backup, restore, or verify data, any existing contents of the log file are
overwritten. The contents of the log file are intended for use by Corel Technical Support.



catalog file name and location text boxes

Specify the name and location of the catalog files. A catalog is a list of all files and their directory
structures in the backup. This catalog file is used to restore files when required.

If you change the location of the catalog files, you must restart the application before the changed
setting takes effect.



file restore options

Indicate how you want to handle files when restoring data. Three options are available: Always Replace
File, Never Replace File, and Prompt Before Replacing File.



Counter
Indicates how many write requests are performed before the contents of the cache buffers are flushed.



Tolerance

Specifies the maximum number of consecutive bad sectors allowed in the history mark area on a
WORM cartridge when it's mounted. If the cartridge contains more consecutive bad sectors than
specified by this value, you can't mount the cartridge.



Max Size

Specifies the maximum logical sector size supported by your drives. If you're using drives that support
different logical sector sizes, set this value for the largest one. For example, if two drives use a sector
size of 1024 bytes and another drive uses a sector size of 2048 bytes, you must set this value to 2048.
The default value for this option is 1024 bytes. Do not change this option unless you're using 2048 bytes
cartridges.



Device Size
Indicates the storage capacity of the largest WORM cartridge you plan to use.



Boot Sector Overwrite
Indicates whether the device driver will allow applications to overwrite the boot sector on cartridges.



Verify Method

Indicates the type of data verification performed when information is written to a cartridge. Three
methods are available: write verify, verify after write, and disabled.
If you use the write verify method, the device driver always issues a SCSI WRITE VERIFY command
when writing data to a cartridge.

b Some older drives don't support the WRITE VERIFY command.

If you use the verify after write method, a SCSI WRITE command is followed by a SCSI VERIFY
command.

The disabled method writes information to the cartridge without performing any verification. This method
is faster than either a write verify or verify after write, but doesn't ensure data integrity.



Timer

Specifies the amount of time that the device driver waits after a write request to flush data from its cache
buffers to the cartridge. The default is one-third of a second.



Buffers

Determines the number of cache buffers allocated for write-once drives. If you aren't using write-once
drives, set this option to zero to maximize system performance.



Time-Out
Specifies the amount of time that the device driver waits for SCSI commands to complete before failing.



Installed Devices
Lists the drive configurations you've previously added to the device driver.



SCSI ID
Indicates the SCSI ID of the drive selected in the Installed Devices list box.



SCSI LUN
Indicates the SCSI LUN of the drive selected in the Installed Devices list box.



Host Adapter Number

Indicates the number of the host adapter to which the drive selected in the Installed Devices list box is
connected.



Number of Volumes

Indicates the number of drive letters that you want the device driver to allocate to the device selected in
the Installed Devices list box.

The device driver examines write-once and rewritable cartridges to determine the number of drive letters
to allocate to the cartridge. If the drive doesn't contain a cartridge, only one drive letter is allocated.

The device driver allocates, by default, one drive letter for each partition on hard drives.



Number of Buffers

Indicates the number of cache buffers allocated for each drive supported by the device driver. Each
buffer uses 512 bytes. If you've loaded the device driver into EMS, 15K is automatically allocated for

cache buffers.



Cache Type

Indicates the type of cache used for write-once and rewritable drives. Four cache types are available:
read, pass through, default, and enhanced rewritable.

The read cache type uses cache buffers only for reading from the media; data is written directly to the
media.

The pass through cache type uses cache buffers for reading and writing data. Data is written to both the
cache and the media at the same time, providing a high-level of data security if a system interruption
such as a power failure occurs.

The default cache type uses the cache buffers differently for write-once and rewritable drives to provide
data security while maximizing performance. Write-once drives use delayed writes; data is written to the
cache buffers and then flushed to the cartridge after one-third of a second of inactivity. Rewritable drives
use pass through caching. Both write-once and rewritable drives use cache buffers for reading data from
the cartridge.

The enhanced rewritable cache type uses delayed writes for both write-once and rewritable drives. This
cache type may provide better write performance than the default cache type. However, if a power
failure occurs, you may lose all the data in the drive's cache buffers which could cause problems with
your disk. For example, when you reboot your system, directories may point to invalid data.



Use Expanded Memory
Specifies whether the device driver is loaded into expanded memory, if it's available.



Pause after loading driver
Determines whether the system boot pauses after loading the device driver.



Output to Screen
Indicates whether the device driver displays configuration information on the screen when loading.



Scan all LUNs
Specifies whether the device driver scans the SCSI bus for LUNSs.



Scan in reverse order
Specifies whether the device driver scans the SCSI bus starting from SCSI ID 7 to SCSI ID 0.



Scan the SCSI Bus at boot time

Indicates whether the device driver scans the SCSI bus for write-once and rewritable drives during
system boot.



Installed Devices
Lists the drive configurations you've previously added to the device driver.



SCSI ID
Indicates the SCSI ID of the drive selected in the Installed Devices list box.



SCSI LUN
Indicates the SCSI LUN of the drive selected in the Installed Devices list box.



Host Adapter Number

Indicates the number of the host adapter to which the drive selected in the Installed Devices list box is
connected.



Output to Screen
Indicates whether the device driver displays configuration information on the screen when loading.



Use Expanded Memory
Specifies whether the device driver is loaded into expanded memory, if it's available.



Pause after loading driver
Determines whether the system boot pauses after loading the device driver.



Disable XA status

Determines whether you can use CDs that use the XA format. If you're using drives that can read XA
format CDs without special handling by the device driver, this option doesn't affect those drives.



Disable Multi-Session

Determines whether the device driver is configured for multi-session CDs. If you're using drives that
don't support multi-session CDs, this option doesn't affect those drives.



Scan the SCSI Bus at boot time
Indicates whether the device driver scans the SCSI bus for CD-ROM drives during system boot.



Scan in reverse order
Specifies whether the device driver scans the SCSI bus starting from SCSI ID 7 to SCSI ID 0.



Set Volume

Specifies that you want the volume set at the level displayed in the Volume panel. If Set Volume isn't
selected, the drive's default volume is used.



Initial Volume Level

Sets the initial volume level from 0 (mute) to 255 (maximum). This panel requires that the Set Volume
checkbox is selected.



SCSI Command Timeout

Specifies a time-out value which by default is 15 seconds for SCSI commands. For example, if an
attempt to access a CD-ROM drive exceeds 15 seconds, an error message is displayed.



CD-Database Read Only

Indicates whether changes you make, such as defining track and artist titles, will be saved to the
database file.



Default CD-ROM

Indicates the letter of the drive from which you want to play CDs by default. This option is useful if you
have more than one CD-ROM drive connected to your system. By default, the drive associated with the
first available drive letter is used.



CD-ROM Polling Interval

Indicates the interval, in milliseconds, at which status information is updated and the drive is checked for
a CD.



track time
Indicates the play time of each track.



number of tracks
Indicates the number of tracks on the CD.



track name
Indicates the name of each track.



Named Devices
Lists the named devices.



Device Type
Specifies the device type of the name selected in the Named Devices list box.



SCsSIID
Displays the SCSI ID of the device selected in the Named Devices list box.



SCSI LUN
Displays the SCSI LUN of the device selected in the Named Devices list box.



Host Adapter Number

Displays the number of the host adapter to which the device selected in the Named Devices list box is
connected.



Minimize on use
Indicates whether the Backup window shrinks to an icon during backup and restore operations.



Allow Screen Saver

Indicates whether screen savers work during backup and restore operations. Using screen savers can
slow down the performance of these operations.



Use a Log File

Indicates whether information generated by the Backup utility is recorded in a log file. The contents of
the log file are intended for use by Corel Technical Support.



Log File Name
Indicates the name and location of the log file if one is used.



Catalog Files Path

Specifies the name and location of the catalog files. A catalog is a list of all files and their directory
structures in the backup. This catalog file is used to restore files when required.

If you change the location of the catalog files, you must restart the application before the changed
setting takes effect.



File Restore Options

Indicates how you want to handle files when restoring data. Three options are available: Always Replace
File, Never Replace File, and Prompt Before Replacing File.



abstract file name
Indicates the name of the file that contains an abstract for the CD if it's available.



active history marker

A type of history marker that's written to the cartridge when you activate a previous history marker using
the ACTIVATE command of the Tools Maintenance menu.



advanced mode

One of two available modes for the Tools utility: normal or advanced. Normal mode uses all defaults
set using the Configuration utility. Advanced mode is intended only for experienced users who want to
change defaults such as formatting options while running the Tools utility.



Advanced SCSI Programming Interface (ASPI)

Refers to an ANSI standard interface that configures the SCSI interface card to handle communication
between applications on your PC and SCSI devices.



ANSI version
Indicates the SCSI version that the device supports.



Application Mode

Indicates the Tools mode, either normal or advanced. Normal mode uses the defaults settings defined
using the Configuration utility. Advanced mode is intended only for experienced users who want to
change defaults such as formatting options while running the Tools utility.



ASPI host

Specifies the host adapter to which the device is connected. Host adapters are numbered starting from
zero.



auto reset mode
Indicates that the device driver automatically resets the device after a failed time-out.



bad sector tolerance

Indicates the maximum number of consecutive bad sectors allowed on the WORM cartridge when the
history mark area is scanned. If this number is exceeded, the device driver won't mount the cartridge.



bibliographic file name
Indicates the name of the file that contains bibliographic information for the CD, if it's available.



BIOS base address
Indicates the starting address in memory where the BIOS is installed, if it's enabled.



Blank history marker

A type of history marker that's written to the cartridge when you use the Blank command of the Tools
History menu. All the existing information on the cartridge is hidden to make the cartridge appear as if all
the information has been erased. However, you can still access the information using other types of
history markers.



cache buffers

A type of RAM storage used by devices to speed up read and write operations. Information stored in the
cache buffers is accessed more quickly than re-reading information from the media.



caching mode
Indicates the caching mode that's specified using the Configuration utility.



caching reads
Indicates that the device driver is using its cache buffers for read operations.



caching writes
Indicates that the device driver is using its cache buffers for write operations.



Capacity test

Determines the physical sector size and the total number of sectors of the media in the drive and
compares these values to a list of valid known sector sizes. A failure may indicate communication or
hardware problems with the drive.



cluster size

Indicates the number of sectors that DOS allocates for each read or write operation. These sectors are
allocated regardless of whether the space is completely used.



command queuing
Indicates that a device can queue multiple SCSI commands.



command status
Indicates a command status code that's issued by devices supported by Corel's device drivers.



compact disc (CD)

A read-only optical disc that contains large quantities of information in either audio or data format. CDs
are used in CD-ROM drives.



copyright file name
Indicates the name of the file that contains copyright information for the CD, if it's available.



Corel drive number
Identifies the class, as defined by Corel, to which the drive belongs.



CorelCDX
A Corel CD-ROM extensions program that interprets data stored on compact discs.



Counter history marker
A type of history marker that's written to the cartridge after 512 write requests are made to the device

driver without a history marker being written to the cartridge. If a system interruption such as a power
failure occurs, counter history markers ensure that the amount of data lost is minimized.



CRLSCSLINI file

Afile that's located in the installation directory. This file defines the configuration of the drivers and
utilities installed in your system. CRLSCSI.INI is intended for use only by Corel Technical Support. Do
not change the information in this file.



current block length
Indicates the size, in bytes, of the current block length.



data cache

Stores the most recently accessed contents of files on the CD. The default buffer size is 1 block (2
sectors).



data cache buffers
Specifies the number of buffers the device driver uses to cache data.



data cache size
Specifies the amount of memory, in bytes, required for rewritable drives.



date formatted
Indicates the date that the cartridge was formatted.



date of the error
Indicates the date that the error occurred.



device
A generic term that refers to any hardware peripheral.



device drivers

Define the configuration of the SCSI devices connected to the system on bootup. Corel's device drivers
are available for virtually all SCSI devices approved through the Corel-certified program.
The installation automatically adds device drivers in your system and identifies the location of the device
drivers using DEVICE statements in your CONFIG.SYS file. You can think of Corel's device drivers using
the following general categories:
CD-ROM device driver — supports SCSI CD-ROM drives.

SCSIPRN device driver _ supports SCSI printers.

Corel TWAIN device driver _ supports SCSI scanners.

Write-Once and Rewritable device driver _ supports many random access SCSI drives such as

hard drives, rewritable drives, multi-function drives, WORM drives, and floptical drives.



device information

A section of the Tools utility information panel that displays the icon that represents the device and the
logical name of the device, the name of the vendor of the device or the name of the ASPI manager for
host adapters, the name of the model of the device, and the device type.



device type
product id

Specifies the peripheral device type as defined by ANSI SCSI standards.



directory cache
Stores information such as the name and location of the files in each sub-directory on the CD.



disconnect enable
Indicates that the drive disconnect option is enabled.



disk eject supported
Indicates that the drive can eject CDs.



DMA channel
Indicates the channel on the DMA chip used by the host adapter for direct memory access.



DMA speed
Indicates the direct memory access transfer rate.



door lock mode
Specifies whether the device supports door locking and whether the device driver can lock the door.



DOS free space
Indicates the amount of physical space that DOS views as available on a WORM cartridge.



DOS volume label
Specifies the cartridge label displayed by DOS.



drive capacity
Indicates the storage capacity of the media in the drive.



drive door locking supported
Indicates whether the drive supports door locking.



drive type
Indicates the type of tape drive you're using such as QIC or DAT.



driver time-out value
Indicates the amount of time that the device driver waits to determine if a SCSI command failed.



driver type

Indicates the version of DOS supported by the device driver. The driver type should always display
DOS4+.



ECMD-111 support

Indicates whether the device complies with standards as defined by the European Computer
Manufacturers' Association.



error tolerance on mount

Indicates the maximum number of consecutive bad sectors allowed in the history mark area of a WORM
cartridge. If this number is exceeded, the device driver won't mount the cartridge.



fast tape erase

A fast tape erase rewinds the cartridge and erases enough information to create a "gap" on the
cartridge. Each drive defines its own gap length.

*  Some drives support a fast erase but may not create this gap.



FAT Size

Specifies whether media is formatted with a 64K file allocation table or a 128K file allocation table. A
128K FAT provides better performance and is recommended for use with DOS 5.0 and higher.



FAT type
Determines the type of file allocation table. Using the Tools utility, you can use a 12-bit or 16-bit FAT.



file allocation table (FAT)

A file allocation table provides a map of the information layout on a cartridge. A least one FAT is required
for each cartridge.



floppy enable
Indicates whether the floppy controller on the host is enabled.



Flush history marker

Before data is written to a cartridge, the device driver buffers may temporarily store information,
depending on the cache type you're using. At regular intervals, the data in the buffers is flushed to the
cartridge. A Flush history marker is also written when you force the driver to flush its contents using the
Flush command of Tools.



flush counter
Indicates the number of write requests made before the device driver automatically flushes its buffers.



flush history marker

A type of history marker that's written to the cartridge when you force the driver to flush its contents
using the Flush command of the Tools utility.



flush timer

Indicates the amount of time that the device waits between consecutive write requests before
automatically flushing its buffers.



format area

Indicates the format area where you want the device driver to mount the cartridge. Each time you format
a WORM cartridge, a format area is created. The format area contains the history markers created after

the format. The last format area is 1. This is the format area mounted when you insert the cartridge. The
next reformat area is 2, and so on.



history marks

The write-once and rewritable device driver writes history markers to the cartridge to take a "snapshot”
of the cartridge information at a specific point in time. History marks help the device driver find
information on the cartridge. The Tools utility can examine these "snapshots" of the cartridge once
they've been written.



host adapter
A term that refers to the SCSI interface card and its ASPI module.



host adapter id
Specifies SCSI ID assigned to the host adapter.



host adapter number

Specifies the number of the host adapter. Numbers are assigned to each host adapter defined in your
CONFIG.SYS file starting from O.



host name
Specifies the manufacturer of the host adapter.



information panel
A component of the Tools utility window that displays information about the selected device.



Internal diagnostics test

Performs the device's internal diagnostic tests. A failure may indicate communication problems with the
drive or a problem with the drive itself.



IRQ level
Indicates the hardware interrupt used by the host adapter.



1SO-9316 support

Indicates whether the device complies with standards as defined by the International Organization for
Standardization.



1S0-9660 interleaving supported

Indicates whether the drive supports CDs created according to the 1SO 9660 interleaving standard. This
standard means that consecutive data isn't written to the CD on consecutive sectors. Interleaving data
may improve performance because when data is read from the CD, the laser can read consecutive
information without waiting for the disk to complete a revolution.



linked commands

Indicates whether the device can execute multiple commands without arbitrating for control of the SCSI
bus between commands.



Log Directory
Specifies the location of the default log file in which information generated by Tools is recorded.



log file
A file in which information generated by a utility is recorded.



Log Name
Specifies the name of the default log file in which information generated by Tools is recorded.



logical device name

A name for the device that's displayed in the information panel of the Tools utility. If the device is
associated with a drive letter, the letter is displayed as the logical name; otherwise, the product name is
used. For tape drives, you can define name using the Name command of the Tools utility Status menu.



logical sector size
Indicates the sector size of the cartridge.



long tape erase

A long erase rewinds the cartridge and erases every block of information on the cartridge. A long erase
may take significantly longer than a fast erase.



LUN scan enabled
Indicates whether all SCSI IDs and LUNs are scanned during the system boot.



maximum block length
Indicates the size, in bytes, of the maximum allowable block length.



maximum logical block address
Indicates the number of sectors on the cartridge.



maximum logical sector size
Indicates the largest sector size supported by the device driver.



maximum physical sector size
Indicates the largest sector size supported by the device driver.



maximum SCSI transfer size
Indicates the largest block of data that the device driver can transfer with one command.



maximum volumes
Indicates the maximum number of volumes supported on media used in the devices.



media

A generic term that refers to all types of disk storage including rewritable, WORM, and tape cartridges,
compact disks, and hard drives.



media capacity
Indicates the available space on a cartridge.



media ejection supported
Indicates whether the drive supports the eject feature.



media removable
Indicates whether you can remove the media from the device.



media type
Indicates the type of cartridge you're using, such as rewritable or WORM.



menu bar

A window component that provides menus you use to work with the selected device. The menus and
their commands reflect the type of device selected.



minimum block length
Indicates the size, in bytes, of the minimum allowable block length.



multiple subunits supported
Indicates whether multiple slots are supported on the same SCSI ID.



no auto sense

Prevents the ASPI manager from performing an automatic request sense command when a SCSI error
is detected returning the device status.



normal mode

One of two available modes for the Tools utility: normal or advanced. Normal mode uses all defaults
set using the Configuration utility. Advanced mode is intended only for experienced users who want to
change defaults, such as cartridge compatibility options, while using Tools.



Number of FATs

Specifies whether one or two file allocation tables are written to the media when it's formatted. Using
only one FAT saves space, but may increase the risk of data loss.



optimization mode
Indicates whether the device driver is optimized for speed or space.



other information

A section of the Tools utility information panel that displays the application mode you're using, the name
of the log file if you're using one, and the current time and date.



path table cache

Stores information about the name and location of each sub-directory on the CD. Each path table cache
buffer accommodates approximately 100 sub-directories.



physical free space
Indicates the available physical space on a WORM cartridge.



physical sector size
Indicates the sector size of the cartridge.



port address
Indicates the 1/O port used by the host adapter.



PREFETCH command supported

Indicates whether the drive supports the SCSI PREFETCH command. In addition to information you
request from a CD, the PREFETCH command reads the next consecutive set of information. This read-
ahead operation may improve performance.



prevent disconnect
Prevents the host from trying to disconnect from the device.



product identifier
Indicates the model of the device.



RI/W subchannel support

Indicates whether R/W subchannels are supported. Standard CDs use subchannels P and Q to store
track information. Subchannels W to R are normally left blank.



raw sector reads supported
Indicates whether the drive can read error correction code as well as data.



Read diagnostic test

A diagnostic test that reads and stores information from three or four sectors on the cartridge and then
reads and stores the same information. If both sets of information aren't the same, the test fails. If you
specify a repetition or continuous loop for the test, the same sectors are read each time the test is run. A
failure may indicate communication problems with the drive or a problem with the drive or cartridge.



Read/Write diagnostic test

A diagnostic test that writes to one sector of a formatted WORM cartridge, reads the data back, and
compares it to the original data. A failure may indicate communication problems with the drive or a
problem with the drive or cartridge. To save space on your WORM cartridge, this test is performed only
once, even if you choose multiple or continuous loops.



Redbook addressing supported

Indicates whether the drive supports addressing as defined by the Philips/Sony Redbook standards for
CD-ROM.



relative addressing

Indicates whether the last logical block addressed is available for the next command. This option is
available only in conjunction with the linked commands option.



removable media
Indicates whether you can remove media from the device.



Repair history marker

A type of history marker that's written to the cartridge when use the REPAIR command of the Tools utility
History menu.



revision level
Indicates the version of the device's firmware.



scan
A function that examines your SCSI bus to determine which devices are connected to your system.



Scan SCSI Bus

Determines whether Tools scans for devices on all SCSI IDs and SCSI LUN 0 or all SCSI IDs and all
SCSI LUNSs.



SCSl address
A term that refers collectively to the host adapter number of the device, the SCSI ID, and the SCSI LUN.



SCSI bus

A term that refers to the set of devices cabled to your SCSI interface card. Each device is cabled to the
next device in the chain. You can include both internal and external devices on the SCSI bus.



SCSIl device
A term that indicates that the device conforms to the SCSI standard.



SCsSIID
A SCSI ID is a unique number from 0 to 7 that's assigned to each device on the SCSI bus.



SCSl interface card

A SCSl interface card is a board that you install in an available expansion slot in your computer to let
you connect devices to your system. The SCSI interface card provides two connectors: one that you use
to daisy-chain internal devices and another that you use to daisy-chain external devices.



SCSI LUN

A SCSI LUN is an optional identifier used to provide a secondary identification number from 0 to 7. For
example, if you're using a CD-ROM drive that contains multiple slots, you may want to assign each slot
a SCSI LUN.



SCSI manager name
Specifies the name of the ASPI module you're using.



SCSI parity enabled
Indicates whether parity checking on the SCSI bus is enabled.



SCSI WRITE VERIFY command supported
Indicates whether the drive supports the SCSI WRITE VERIFY command.



sector packing

Indicates whether sector packing is supported. Sector packing refers to the data translation made by the
device driver between the physical sector size and the DOS requested logical sector size of 512 bytes.



sector size
Indicates the sector size of the media. The sector size must be 2048K to use CorelCDX (or MSCDEX).



sectors lost
Indicates the number of sectors that have been lost on a WORM cartridge.



Seek diagnostic test

Forces the drive to seek to a set of random sector locations. A failure may indicate communication
problems with the drive or a problem with the drive or cartridge.



sense code
Indicates a code as defined by the ANSI SCSI-2 standard.



sense key
Indicates a key as defined by the ANSI SCSI-2 standard.



slot
A compartment within a CD-ROM caddie for a compact disk. You may assign a unique LUN to each slot.



slow SCSI transfers

Indicates whether a buffer mode transfer is used instead of a byte-by-byte transfer during a SCSI data
phase.



Small Computer Systems Interface (SCSI)
An ANSI standard that provides high-speed connectivity among peripheral devices and a PC.



spin up/down supported

Indicates whether the drive supports spin up and spin down commands issued by the device driver
during mount and dismount operations.



starting sector number
Determines the sector number where the device driver will start searching for the format area.



status panel
Displays messages about the current operation or the location of your mouse.



synchronous negotiation enabled
Indicates whether SCSI negotiation for synchronous transfer is enabled.



synchronous transfer

Indicates whether the device supports synchronous data transfers; otherwise, the device supports
asynchronous data transfers.



system cache buffers
Specifies the number of buffers required for WORM cartridges.



system cache size
Specifies the amount of memory, in bytes, required for WORM drives.



Tape Erase method

Determines the type of erase performed for tape cartridges. A fast tape erase rewinds the cartridge and
erases enough information to create a "gap" on the cartridge. Each drive defines its own gap length.

*  Some drives support a fast erase but may not create this gap.

A long tape erase rewinds the cartridge and erases every block of information on the cartridge. A long
erase may take significantly longer than a fast erase.



termination

Prevents SCSI signals from conflicting with more recent signals. Only the devices at the ends of the
SCSI bus must be terminated; other devices must not be terminated.



terminator
A type of resistor used to terminate the SCSI bus. Terminators are supplied with your devices.



time formatted
Indicates the time that the cartridge was formatted.



time of the error
Indicates the time that the error occurred.



Timer history marker

A type of history marker that's written to the cartridge when data in the device driver buffer is
automatically flushed. By default, the unwritten contents of the device driver buffers for a drive are
written to the media if the time between consecutive write requests exceeds one-third of a second.



tool bar
A component of most Corel utilities that provides quick access to functions available from the menu.



total clusters
Indicates the number of clusters used on the cartridge.



total logical sectors
Indicates the sector size of the cartridge.



total physical sectors
Indicates the sector size of the cartridge.



track information

A term that refers to the information displayed in the Track list box of the CD-Audio utility. By default, this
information includes the program number, track play time, track type, and track name.



tray locking supported
Indicates whether you can lock CDs in the drive.



UPC code
Displays the universal product code information if it's available.



User history marker

A type of history marker that's written to the cartridge when you use the USER command of the Tools
utility History menu.



variable length blocks

Indicates whether the drive supports variable length blocks. Variable length blocks let you write almost
any amount of data to the tape within the specified minimum and maximum block lengths.



vendor name
vendor id

Indicates the name of the manufacturer of the device.



driver version
Indicates the version and revision level of the device driver.



volume capacity

Indicates the cartridge volume. The volume is equal to the sector size multiplied by the number of
sectors on the cartridge plus one.



volume name
Specifies the name of the volume on the cartridge.



wide bus (16 bit)

Indicates whether the device supports 16-bit wide data transfers. If the device doesn't support either 16-
bit or 32-bit wide data transfers, the default is 8-bit.



wide bus (32 bit)
Indicates whether the device supports 32-bit wide data transfers.



writable CD-ROM drive
Indicates whether the drive supports writable CDs.



write errors
Indicates the number of write errors that have occurred on a WORM cartridge.



write protect status
Indicates whether the cartridge is write-protected.



write verify mode
Indicates whether the device driver supports the WRITE VERIFY.



Zero Media

Specifies whether zeros are written to every sector of the media during the format operation. This
operation provides a method of testing every sector. If a bad sector is found, it may be possible to remap
it.



Low level
Specifies whether a low-level format must be performed for each format operation.



Corel Media format

Includes reserved system sectors at the beginning of the cartridge. This format is intended only for use
with WORM media. Using the Corel Media format may cause problems if used with another vendor's
software.



DOS Media format

Uses the same media layout as DOS formatted floppy disks. For removable media, this format is
selected by default.



Hard Disk Media format

Uses the same media layout as DOS formatted fixed disks. One partition table is created with one
partition. For fixed disks, this format is selected by default.



Active history marker

Written to the cartridge when you activate a previous history marker using the ACTIVATE command of
the Tools utility Maintenance menu.



catalog files

Catalog files are created when you backup data. Do not delete the catalog files. These files store
information that's required to restore the files. For example, catalog files include the names of the files
backed up and their original location.






